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subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software clause at
DFARS 252.227-7013.

Cabletron Systems, Inc., 35 Industrial Way, Rochester, New Hampshire 03866-5005.

2. (a) This computer software is submitted with restricted rights. It may not be used,
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(il | Preface

Use this guide as a reference for the SPECTRUM Fast Ethernet SmartSwitch
Module management software. Before using this guide, you should be familiar
with SPECTRUM's functions and navigational techniques as described in the
Administrator’s Reference and the Operator’s Reference.

For the purposes of this guide, a Fast Ethernet SmartSwitch Module is

referred to as a “device.”

What Is in This Guide

The organization of the Fast Ethernet SmartSwitch Module Management

Module Guide is as follows:

Chapter

Chapter 1
Introduction

Chapter 2
Device Views

Chapter 3
Configuration Views

Chapter 4
Event and Alarm Messages

Chapter 5
Application Views

Description

Describes the devices, the management module
software, and the model types.

Describes the Device views representing the
devices.

Describes the Configuration views for the devices
and the network management information
provided by the views.

Lists and explains the event and alarm messages
generated in the Event Log or Alarm Manager for
the device model type.

Describes the Application views and the
application-specific information for the devices.

9032073 E2



Conventions

Conventions

This guide uses the following conventions;

= Menu selections and buttons referenced in text appear in bold; for
example, Configuration or Detail.

= Buttons appear as shadowed boxes when describing their use; for
example:

= Menu navigation appears in order of selection; for example, Icon
Subviews -> Utilities -> Application.

« Referenced chapter titles and section headings appear in italics.
= Referenced documents appear in bold italics.

= A Fast Ethernet SmartSwitch Module is referred to as a “device.”

Related SPECTRUM Documentation

It is important when using this guide that you have a clear understanding of
SPECTRUM functionality and navigation techniques as described in the
following recommended documentation:

Operator’s Reference

Administrator’s Reference

Report Generator User’s Guide

Application View Reference

Getting Started with SPECTRUM 4.0 for Operators

Getting Started with SPECTRUM 4.0 for Administrators
How to Manage Your Network with SPECTRUM

This guide also references the following documents:

SPECTRUM Portable Management Application Tools Guide
SPECTRUM Routing Services Management Module Guide

SPECTRUM Portable Management Application for the 2E42 Fast
Ethernet SmartSwitch User’s Guide

Preface Fast Ethernet SmartSwitch Module
X Management Module Guide



Other Related Documentation

Other Related Documentation

Refer to the following documentation for more information on managing TCP/
IP-based networks:

Martin, James, Kathleen Kavanagh Chapman, Joe Leben. Local Area
Networks, Architectures and Implementations, 2nd ed. Englewood Cliffs,
NJ: Prentice Hall, 1994.

Rose, Marshall T. The Simple Book — An Introduction to Management of
TCP/IP-based Internets. Performance Systems International, Inc.

Stallings, William. Data and Computer Communications, 4th ed. New
York: Macmillan Publishing Company, 1994.

Tanenbaum, Andrew S. Computer Networks, 3rd ed. Englewood Cliffs, NJ:
Prentice Hall, 1996.
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INntroduction

What Is in This Chapter

This chapter introduces the SPECTRUM management module covering the
Fast Ethernet SmartSwitch Modules described below. It describes the
following:

= Fast Ethernet SmartSwitch Modules

< SPECTRUM Support
- Accessing SPECTRUM Views from the Device Icon
- Accessing Device-Specific Subviews

< SPECTRUM Views Roadmap

= SPMA Support

Fast Ethernet SmartSwitch Modules

The 8H02-16, 2E42-27, 2E42-27R, 2E43-27, and 2E43-27R Fast Ethernet
SmartSwitch Modules are all high performance Ethernet switching devices
that provide Fast Ethernet uplinks.

The 8HO02-16 is a 16-port device having 14 standard 10Base-T front panel
ports that are supported by RJ-45 connectors and two 100Base-TX or multi-
mode fiber 100Base-FX uplinks using Fast Ethernet Port Interface Modules.

The 2E42-27 and 2E42-27R devices expand the capabilities of the 8H02-16 by
providing 27 ports including 24 standard Ethernet ports with RJ-45
connectors, two slots for Fast Ethernet Port Interface Modules, and one slot
for a High Speed Interface Module to provide a high-speed ATM uplink or
FDDI connectivity. The 2E42-27 has a single power supply and the 2E42-27R
has dual redundant power supplies.

9032073 E2
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SPECTRUM Support

The 2E43-27 and 2E43-27R provide the same feature set as the 2E42-27 and
2E42-27R but come equipped with two RJ21 connectors to support 24 ports of
switched Ethernet rather than the 24 RJ45's. This allows the use of Telco
cables in the wiring closets with patch panels to reduce the complexity of cable
management.

All five devices offer RMON, port redirection, broadcast suppression, and full
duplex support on all interfaces, with support for IEEE Auto-Negotiation on
the 100Base-TX ports.

SPECTRUM Support

When modeling a device, the model type SS8H appears in the Select Model
Type dialog box. The names listed below refer to the model names used in
SPECTRUM to specify attributes, actions, and associations for Fast Ethernet
SmartSwitch Modules:

= 8H02_16 (Fast Ethernet SmartSwitch Module, Model 8H02-16)
e 2E42 27 (Fast Ethernet SmartSwitch Module, Model 2E42-27)
e 2E42_27R (Fast Ethernet SmartSwitch Module, Model 2E42-27R)
= 2E43_27 (Fast Ethernet SmartSwitch Module, Model 2E43-27)
e 2E43_27R (Fast Ethernet SmartSwitch Module, Model 2E43-27R)

Accessing SPECTRUM Views from the Device Icon

The Device icon provides access to SPECTRUM views that display device-
specific information. Access these views using double-click zones (Figure 1-1)
or Icon Subviews menus (Figure 1-2).

To access the Icon Subviews menu, do the following:
1. Highlight the icon.

2. From the View menu, select Icon Subviews or click the applicable mouse
button (middle or right). Refer to the Operator’s Reference for
information on configuring your mouse.

Introduction Fast Ethernet SmartSwitch Module
1-2 Management Module Guide



SPECTRUM Support

Accessing SPECTRUM Views from the Device Icon

Figure 1-1. Using Double-Click Zones to Access SPECTRUM Views

Accesses the Configuration views; refer
to Chapter 3, Configuration Views.

Accesses the Device Topology view;
refer to the Operator’s Reference.

\Model ame

Accesses the Device views; refer to
Chapter 2, Device Views.

Accesses the Performance view;

refer to the Operator’s Reference. Accesses the Application views; refer

to Chapter 5, Application Views.

Accesses the Configuration views; refer to
Chapter 3, Configuration Views.

Accesses the Performance view;

Accesses the Device views; ModelName ,
- refer to the Operator’s Reference.

refer to Chapter 2, Device
Views.

N

Accesses the Device Topology view;

refer to the Operator’s Reference. Accesses the Application views; refer
to Chapter 5, Application Views.

9032073 E2 Introduction
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SPECTRUM Support

Accessing SPECTRUM Views from the Device Icon

Figure 1-2. Using the Icon Subviews Menu to Access SPECTRUM Views

Model Name

[
=]
A

8H02_16

View

1=
Go Back Ctrl+b
Go Up >
Icon Subviews >l.=
View Path >
New View > ﬁlecl)vsieate Ctrl+>c
Bookmarks > AIarr?ls
BlicHhlislon] Eerformance
Current View Info...
Notes...
NOtes... Utlities >
Jump by name... Z00m e
Aol ~ | Device >| :
Map Hierarchy >| DevTop Chassis |
Page > Interface
Physical
Introduction Fast Ethernet SmartSwitch Module

1-4 Management Module Guide



SPECTRUM Support

Accessing Device-Specific Subviews

Accessing Device-Specific Subviews

Figure 1-3.

Icon Subviews menus provide access to views that display device-specific
information. Figure 1-3 shows an example of an Icon Subviews menu for the
Bridging icon located within the Chassis Device view. The device-specific Icon
Subviews menu selections are described under the applicable section within
this guide. The menu selections that are common to all devices are described
in the Administrator’s Reference and the Operator’s Reference.

To access the Icon Subviews menu using the View menu, do the following:

1. Highlight the icon.

2. From the View menu, select Icon Subviews.

To access the Icon Subviews menu using the mouse button, do the following:
1. Position the mouse pointer on the icon.

2. Click the applicable mouse button (middle or right). Refer to the
Operator’s Reference for information on configuring your mouse.

Accessing Device-Specific Subviews

2E42-27R

Bridging

B B = m =5 e EE

=t
Close Ctrl +C
Navigate >
Alarms
Performance Common
Notes...
Utilities >

Bridge Performance
Bridge Detall

Bridge Model Information
Special Database Device Specific
Spanning Tree Information
Static Database Table
Transparent Bridge Info

9032073 E2
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SPECTRUM Views Roadmap

SPECTRUM Views Roadmap

Figure 1-4 shows a “roadmap” of the SPECTRUM views for this device. These
views are accessible from double-click zones (Figure 1-1) and Icon Subviews
menus (Figure 1-2 and Figure 1-3).

Introduction Fast Ethernet SmartSwitch Module
1-6 Management Module Guide



SPECTRUM Views Roadmap

Figure 1-4. SPECTRUM Views Roadmap

9032073 E2 Introduction
1-7



SPMA Support

SPMA Support

SPECTRUM also supports SPECTRUM Portable Management Application
(SPMA) functionality for these devices. Figure 1-5 shows an example of an
SPMA Applications view. To open the SPMA Applications view, do the
following:

1. Highlight the Device icon.

2. From the View menu, select Icon Subviews -> Utilities ->
Applications.

Figure 1-5. SPMA Applications View

| Applications

SIS | FETETE i S,
S i SR i I
10

[eeraopubm |
[TerPovmess |

| —e—

The SPMA Applications view provides the buttons, described below, that are
used to access SPMA-specific views and dialog boxes. For more information,
refer to the SPECTRUM Portable Management Application for the 2E42
SmartSwitch User’s Guide or the SPECTRUM Portable Management
Application Tools Guide.

Introduction Fast Ethernet SmartSwitch Module
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SPMA Support

Community Names |

This button accesses the Community Names Tool, which allows you to change
device community names. Refer to Chapter 3, Using the SPMA Community
Names Tool, of the Tools Guide.

Frame Priorities |

This button accesses the Frame Priorities window, which allows you to set the
priority in which frames types are queued for transmission by the device.
Refer to the 2E42 User’s Guide.

System Resources |

This button accesses a window that displays current physical and logical
system resources and utilizations on the device. Refer to the 2E42 User’s
Guide.

Broadcast Suppression |

This button allows you to monitor broadcast traffic statistics on each interface
and set thresholds to limit broadcast traffic over the device. Refer to the 2E42
User’s Guide.

MAC Priorities |

This button accesses the MAC Priorities window, which allows you to set the
priority in which frames are queued by MAC address for transmission by the
device. Refer to the 2E42 User’s Guide.

Trap Table |

This button accesses the SNMP Trap Tool, which allows you to establish
which network management workstations on your network receive trap
alarms from a selected device. Refer to Chapter 6, Using the SNMP Traps
Tool, of the Tools Guide.

Port Priorities |

This button accesses the Port Priority window, which allows you to set the
priority in which frames are queued on selected ports for transmission by the
device. Refer to the 2E42 User’s Guide.

Basic Alarms I

This button allows you to configure alarms and events for each available
interface. Refer to the 2E42 User’s Guide.

9032073 E2
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SPMA Support

Bridge View |

This button provides an overview of bridging information for each port and
allows you to access all other bridge-related options. Refer to the 2E42 User’s
Guide.

Generic SNMP (MIB 1 1) |

This button accesses the MIB I, MIB 11 Tool, which allows you to change MIB
I and MIB |1 object values. Refer to Chapter 2, Using the MIB I, MIB 11 Tool,
of the Tools Guide.

TFTP Download |

This button accesses the TFTP Download Tool, which allows you to upgrade
firmware on Cabletron devices equipped with Flash EEPROMSs. Refer to
Chapter 5, Using the TFTP Download Tool, of the Tools Guide.

Introduction Fast Ethernet SmartSwitch Module
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Device Views

What Is in This Chapter

This chapter describes the following Device views and subviews available for
the Fast Ethernet SmartSwitch Modules.

e Interface Device view
« Chassis Device view
= Physical Device view

Refer to Chapter 1, Introduction, for information on accessing SPECTRUM
views from the Device icon and accessing device-specific subviews.

Interface Device View

This section describes the Interface icons and the Interface Options panel
displayed in the Interface Device view. This view provides dynamic
configuration and performance information for each interface on the device. If
the configuration changes, SPECTRUM modifies the Device view after the
next polling cycle to reflect the new configuration. This view also provides a
Device icon that allows you to monitor the device operation and to access other
device-specific views. Figure 2-1 shows an example of the Interface Device
view for the Model 8H02-16. The views for the Model 2E42-27 and Model
2E43-27 are similar except for the number of Interface icons.

9032073 E2
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Interface Device View

Figure 2-1. Interface Device View

=

Model Network Address | System Up Time
Contact Manufacturer

Description Device Type

Location | Primary Application I Bridging = Serial Number

Filter I Physical =] Network Information I ADDRESS =

Interface Description

Device Views Fast Ethernet SmartSwitch Module
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Interface Device View

Interface Icon

Interface Icon

These icons represent the interfaces or ports of the device. The icons identify
the type of interface or port (e.g., Ethernet) and provide statistical
information. Figure 2-2 shows an example of an Interface icon, its Icon
Subviews menu, and its labels/double-click zones

The callouts (a through f) displayed in the illustration below identify the
label and, if available, the view to which it provides double-click zone access.
For example, the icon area referred to by callout (b) displays the
administrative status and provides double-click access to the Port
Configuration - CSIIfPort view.

The menu displayed in the illustration is the Icon Subviews menu for that
Interface icon.

Figure 2-2. Interface Icon
(a) (b)
I con Subviews Menu
blose Ctrl +c
Navigate >
Alarms
Performance ETHERNET (C)
Notes... 0:0:1D:F:FD:B6 }——-— (d)
Utiities >
Configuration — (e)
Model Information 3 (f)
a. Interface Label
b. Administrative Status Label/Port Configuration-CSlIfPort View
c. Interface Type Label
d. MAC Address Label/CSI Interface Port Model Information View
e. Network Information Label/Network Information Panel Dialog Box
f. Gauge Label/Performance - CSIIfPort View
9032073 E2 Device Views

2-3



Interface Device View

Interface Icon

Interface Icon Subviews Menu

Table 2-1.

Table 2-1 describes the Interface icon device-specific subviews menu
selections. For information on accessing device-specific subviews menus, see
Chapter 1, Introduction.

Interface lcon Subviews Menu

Menu Selection Description

Configuration Opens the Device Configuration view described
in Chapter 3, Configuration View.

Model Information Opens the Model Information view described in

the Operator’s Reference.

Interface Label

This label displays the interface (port) number.

Administrative Status Label

This label displays the status of this interface. Double-click this label to open
the Port Configuration - CSIIfPort view described in Chapter 3, Configuration
Views. Table 2-2 and Table 2-3 list the possible states relative to the
application selected (Physical or Bridging). The default application for this
view is Physical (MIB-11). To select the application to be displayed, click the
Filter menu button in the Interface Options panel. (Refer to the Interface
Options Panel description later in this chapter for more information on the
Filter menu button.)

Table 2-2. Administrative Status for the Physical or MIB Il Application
Color Status Description
Green ON Port is operational.
Blue OFF Port is off.
Yellow TST Port is in the test mode.
Device Views Fast Ethernet SmartSwitch Module
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Interface Device View

Interface Icon

Table 2-3. Administrative Status for the Bridging Application
Color Status Description
Green FWD Bridge port is forwarding.
Blue DIS Port is disabled.
Magenta LST Bridge is in the listening mode.
Magenta LRN Bridge is in the learning mode
Orange BLK Bridge port is in the blocking mode.
Red BRK Bridge port is broken.
Blue UNK Status is unknown.

Interface Type Label

This label displays the interface type. Table 2-4 lists the possible interface

types.
Table 2-4. Interface Types
Type Description
Other None of the following
Reg1822 Regular 1822
HDH1822 HDLC Distant Host protocol
DDNX25 Defense Data Network X.25
rfc877X25 RFC877 X.25
Ethernet Ethernet CSMA/CD
is088023 ISO CSMA/CD
is088024 I1SO token bus
15088025 ISO token ring
15088026 ISO man
starLan StarLAN IEEE 802.3
ProtlOMB ProNET 10 Mbps
Prot80OMB ProNET 80 Mbps
HyChan Hyperchannel
FDDI Fiber Distributed Data Interface
LAPB X.25 Line Access Procedure, Balanced
SDLC IBM Synchronous Data Link Control protocol
T1 T1 link (USA and Japan)
9032073 E2 Device Views
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Interface Device View

Interface Icon

Table 2-4. Interface Types (Continued)
Type Description
CEPT T1 link (Europe)
BasicISDN Basic Integrated Services Digital Network
PrimISDN Proprietary Integrated Services Digital
Network
PPSerial Proprietary Point to Point Serial
PPP Point to Point Protocol
SFTWARLPBK Software Loopback
CLNPoverIP Connectionless Network Protocol over IP
Enet3MB Ethernet 3 Mbps
XNSoverlP Xerox Network Service Protocol over IP
SLIP Generic Serial Line IP
ULTRA ULTRA Technologies
T-3 T3 link
SMDS Switched Multimegabit Data Service
FrameRelay T1 Frame relay

MAC Address Label

This label displays the MAC address of the device interface. Double-click this
label to open the CSI Interface Port Model Information View display described
in the Operator’s Reference.

Network Information Label

This label displays user-selectable network information (Address, Name, or
Mask). The default is Address.

To change this label's display, use the Interface Options panel described later
in this chapter, or do the following:

1. Double-click the label to open the Network Information Panel dialog box.
2. Click the network information entry you wish to display.

3. Click OK.

Device Views Fast Ethernet SmartSwitch Module
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Interface Device View

Gauge Label

Interface Options Panel

This label displays the performance statistic determined by the Gauge Control
Panel for this interface. (Refer to the Gauge Control Panel description later in
this chapter for more information.) Double-click this label to open the
Performance - CSIIfPort view described in the Operator’s Reference.

Interface Options Panel

This area of the Interface Device view (Figure 2-1) allows you to modify the
presentation of a highlighted icon. Double-click a non-text area of this panel to
open the Gauge Control Panel view described later in this chapter. The
Interface Options panel provides the information described below.

Filter

This menu button allows you to select the application to be displayed by the
Interface icons. You can select other applications such as IP routing if the
SPECTRUM Routing Services Management Module is loaded. For more
information, refer to the Routing Services Management Module Guide.

Network Information

This menu button allows you to select the type of information displayed in the
Network Information label of the highlighted icon. Possible selections are
ADDRESS, NAME, or MASK.

Interface Description
This field provides a description of the highlighted interface. If no interface is
highlighted, this field is empty or shows the interface previously highlighted.

Gauge Control Panel

This view (Figure 2-3) allows you to change the type of statistical information
displayed on the Gauge label of the Interface icon. To access the Gauge
Control Panel view, double-click the background of the Interface Options
panel, or do the following:

1. Highlight the Interface Options panel.

2. From the View menu, select Icon Subviews -> Gauge Control Panel.

9032073 E2
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Interface Device View
Gauge Control Panel

Figure 2-3. Gauge Control Panel

Gauge Mode Selected Attribute

Load

Gauge Type

% Discard
% Filtered

l Apply l Keep Settings

Gauge
l Reset | Close Buttons
l Default

The Gauge Control Panel provides the following:

= Gauge Mode area

= Selected Attribute area
= Gauge Type area

= Gauge buttons

Gauge Mode

This area allows you to select the type of information shown on the Gauge
label of the Interface icon: Rates, Totals, or Percentages. The Percentages
selection displays the percentage of the selected interface compared to the rest

of the interfaces.

The color displayed on the Gauge label depends upon the particular mode and
statistical attribute selected. Table 2-5 and Table 2-6 list the attributes and
their corresponding colors for the Totals mode and Rates mode, respectively.
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Interface Device View

Gauge Control Panel

Table 2-5. Totals Mode: Attributes and Corresponding Color
Selected Attribute Color
Errors Orange
In Packets Blue
Out Packets Blue
In Octets Green
Out Octets Green
Discards Tan
Forwarded Purple
Host Bound Yellow
Transmitted White
Filtered Gray
Table 2-6. Rates Mode: Attributes and Corresponding Color
Selected Attribute Color
Load Green
Load In Green
Load Out Green
Packet Rate Blue
In Packet Rate Blue
Out Packet Rate Blue
% Discard Tan
% Filtered Gray
%Forwarded Violet
%Host Bound Yellow
%Error Orange
%Transmitted White
Selected Attribute
This area allows you to select the statistical attribute displayed on the
Interface icon’s Gauge label. The label changes color to reflect the attribute
selected.
9032073 E2 Device Views
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Interface Device View

Gauge Control Panel

Gauge Type
This area allows you to select either a numeric or linear display on the Gauge
label.

Gauge Buttons
The following describes the Gauge buttons:

Applies the current settings to the Gauge label for as long as the view is open.

| Keep Settings |

Saves the current settings while SpectroGRAPH is running. Settings return to
default when you restart SpectroGRAPH.

Returns the settings to the previously saved values.

Close

Closes the Gauge Control Panel view.

Returns the settings to the SPECTRUM default.

Device Views
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Chassis Device View

Chassis Device View

This view uses a Chassis Device icon to provide a logical representation of the
device chassis and its interfaces or ports. The Chassis Device icon provides
menu and double-click zone access to the views that monitor the interfaces.

Figure 2-4 shows an example of the Chassis Device view for the 2E42-27R

device.

Figure 2-4. Chassis Device View

Model Name
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Location
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Chassis Device View

Chassis Device Icon

Chassis Device Icon

This icon is a logical representation of the physical device and its front panel
interfaces or ports. This section describes the information available from the
Chassis Device icon. Figure 2-5 shows an example of the Chassis Device icon
for the 2E42-27R device.

The callouts displayed in this illustration identify the label name and the
view to which it provides double-click access. For example, Device Type
Label/Device Configuration View displays the device model number and
provides double-click access to the Device Configuration view.

The menus displayed in the illustration are the Icon Subviews menus for that

label.
Figure 2-5. Chassis Device Icon
Device | con Subviews Bridging I con Subviews
—i=t
= 1
Close Ctrl +c
Close Ctrl +c Navigate >
Navigate > AR
Alarms PGS Interface | con Subviews
Performance Notes
=
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Ut 'tf',es , Bridge Performance Navigate
Configuration Bridge Detail AR >
Ap[()jllclatl?n Dlsplay - Bridge Model Information Performance
e I? "? orm_atlon Special Database Notes...
Ap;zjlclatlon View Spanning Tree Information Utilities =
hifereltite ieitets Static Database Table Configuration
| Transparent Bridge Info
Device Type Label/ |
Device Configuration View |
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L I
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Chassis Device View

Device Type Label

Chassis Device Icon

This label identifies the type of device. (Refer to Figure 2-5.) Double-click this
area to open the Device Configuration view described in Chapter 3,

Configuration Views.

Device Icon Subviews Menu

Table 2-7 lists each of the device-specific Icon Subviews menu selections
available for this device. For information on accessing device-specific
subviews, see Chapter 1, Introduction.

Table 2-7. Device Icon Subviews Menu

Menu Selection

Description

Configuration

Opens the Device Configuration view described in Chapter 3,
Configuration Views.

Application Display

Opens the Application menu selection. This menu selection
allows you to select the physical or bridging application.

Model Information

Opens the Model Information view described in the
Operator’s Reference.

Application View

Opens the Application view described in Chapter 5,
Application Views.

Module Notes

Opens the Module Notes dialog box.

Application Label

This label provides access to the Bridging Icon Subviews menu. (Refer to
Figure 2-5.) Double-click the Application label to open the CSI Bridging
Performance view described in the Operator’s Reference.

Bridging Icon Subviews Menu

Table 2-8 lists specific Icon Subviews menu selections for the Application
Label. For information on accessing device-specific subviews, see Chapter 1,

Introduction.
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Chassis Device View

Chassis Device Icon

Table 2-8. Application Label Icon Subviews Menu
Menu Selection Description
Bridge Performance Opens the Performance view described in the
Operator’s Reference.
Bridge Detail Opens the Detail view described in the Operator’s
Reference.

Bridge Model Information | Opens the Model Information view described in the
Operator’s Reference.

Special Database Opens the Special Database view.

Spanning Tree Opens the Spanning Tree Information view
Information described in the Application View Reference.
Static Database Table Opens the Static Database Table view described in

the Application View Reference.

Transparent Bridge Info Opens the Transparent Bridge Information view,
with Forwarding Database and Port Tables
described in the Application View Reference.

Interface Labels

These labels identify the number and activity status of each port. (Refer to
Figure 2-5.) Table 2-9 and Table 2-10 list the possible states relative to the
application selected. Double-click the label to open the Performance -
CSllIfPort view described in the Operator’s Reference.

Table 2-9. Interface Status for the Bridging Application
Color Status Description
Green FWD Bridge port is forwarding.
Blue DIS Port is disabled.
Magenta LST Bridge is in the listening mode.
Magenta LRN Bridge is in the learning mode
Orange BLK Bridge port is in the blocking mode.
Red BRK Bridge port is broken.
Blue UNK The status is unknown.
Device Views Fast Ethernet SmartSwitch Module
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Chassis Device View

Chassis Device Icon

Table 2-10. Interface Status for the Physical (MIB Il) Application
Color Status Description
Green ON Port is operational.
Blue OFF Port is off.
Yellow TST Port is in the test mode.

Interface Icon Subviews Menu

This menu’s Configuration option opens the Configuration dialog box, which
allows you to enable or disable the selected port. For information on accessing
device-specific subviews, see Chapter 1, Introduction.

FDDI Label

This label provides access to the FDDI Icon Subviews menu. (Refer to
Figure 2-5.) Double-click this label to open the FDDI Application views
described in the Operator’s Reference.

FDDI Icon Subviews Menu

Table 2-11 describes each of the Icon Subviews menu selections available for
FDDI. For information on accessing device-specific subviews, see Chapter 1,
Introduction.

Table 2-11. FDDI Label Icon Subviews Menu
Menu Selection Description
FDDI Performance Opens the FDDI Performance view. (Not available for
FddiNoMAC).
FDDI Configuration Opens the FDDI Configuration view.
FDDI Station List Opens the FDDI Station List view. (Not available for
FddiNoMAC).
FDDI Model Opens the Model Information view for FDDI.
Information
9032073 E2 Device Views
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Chassis Device View

Chassis Device Icon

Logical Ports Labels

These labels provide access to the Logical Port Icon Subviews menu.
Double-click a label to open the Port Configuration View.

Logical Ports Icon Subviews Menu

Table 2-12 describes each of the Icon Subviews menu selections. For
information on accessing device-specific subviews, see Chapter 1,

Introduction.

Table 2-12. Logical Ports Icon Subviews Menu
Menu Selection Description

Port Notes Opens the Port Notes facility.

Enable/Disable Port Enables or disables the selected port.

Port Configuration Opens the Port Configuration view.

View
Device Views Fast Ethernet SmartSwitch Module
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Physical Device View

Physical Device View

This view provides a static image of the device and its ports or interfaces and
does not change to reflect configuration status. Figure 2-6 is an example of the
Physical Device view for the 8H02-16 device.

Figure 2-6. Physical Device View
odel Na et Aaare e p Time
De ptio Device Type
ocatio Prime Applicatio dging eria be
Smgrts\/\gtgg 101100 Smart
WITH Securerast Virtual Networking
Eemm—— I RN . ...
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Configuration Views

What Is in This Chapter

This chapter describes the Configuration views available for the Fast Ethernet
SmartSwitch Modules. These views display network configuration and
operating information for the device and its interfaces.

The following Configuration views are available for this device:

= Device Configuration

= Port Configuration - CSlIfPort
« FddiMAC Device Configuration
= Port Configuration

Refer to Chapter 1, Introduction, for information on Accessing SPECTRUM
Views from the Device Icon and Accessing Device-Specific Subviews.
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Device Configuration View

Device Configuration View

This view provides device -specific configuration information as well as access
to other views that allow you to configure device components.

Device Configuration Information

This section of the Configuration view displays the following device-specific
information.

Contact Status
Indicates whether a connection with the device has been established.

This view also provides the following SPMA view buttons that allow you to
configure this device. Refer to the SPECTRUM Portable Management
Application Tools Guide for details on the views accessible from these
buttons.

Component Tablel

Opens the Community Name window, which provides information on the Fast
Ethernet SmartSwitch Module components.

Download Application |

Opens the TFTP Download View, which enables you to upgrade the firmware
for a Fast Ethernet SmartSwitch Module from a TFTP Boot or Bootp Server.

Trap Table

Opens the Trap Table, which allows you to set up your workstation to be
notified of traps received and sent by the Fast Ethernet SmartSwitch Module.

Configuration Views Fast Ethernet SmartSwitch Module
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Device Configuration View

Interface Configuration Table Information

Interface Configuration Table Information

This table within the Device Configuration view provides the following
configuration information about the device’s interfaces or ports.

Number of Interfaces
Displays the number of interfaces or ports available for this device.

Index
Displays the interface or port number.

Type
Displays the type of hardware interface or port. Table 3-1 lists the possible
interface types.

Table 3-1. Interface Types
Type Description
Other None of the following
Reg1822 Regular 1822
HDH1822 HDLC Distant Host protocol
DDNX25 Defense Data Network X.25
rfc877X25 RFC877 X.25
Ethernet Ethernet CSMA/CD
is088023 1ISO CSMA/CD
15088024 ISO token bus
is088025 I1SO token ring
is088026 ISO man
starLan StarLAN IEEE 802.3
ProtlOMB ProNET 10 Mbps
Prot80MB ProNET 80 Mbps
HyChan Hyperchannel
FDDI Fiber Distributed Data Interface
LAPB X.25 Line Access Procedure, Balanced
SDLC IBM Synchronous Data Link Control protocol
T1 T1 link (USA and Japan)
CEPT T1 link (Europe)
BasicISDN Basic Integrated Services Digital Network
PrimISDN Proprietary Integrated Services Digital
Network
PPSerial Proprietary Point to Point Serial
9032073 E2 Configuration Views
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Device Configuration View
Interface Configuration Table Information

Table 3-1. Interface Types (Continued)
Type Description
PPP Point to Point Protocol
SFTWARLPBK Software Loopback
CLNPoverIP Connectionless Network Protocol over IP
Enet3MB Ethernet 3 Mbps
XNSoverlP Xerox Network Service Protocol over IP
SLIP Generic Serial Line IP
ULTRA ULTRA Technologies
T-3 T3 link
SMDS Switched Multimegabit Data Service
FrameRelay T1 Frame relay
Phy Address

Displays the physical (MAC) address of the interface or port.

Max Frame Size
Displays the maximum frame size for the interface or port.

Oper Status
Displays the current operational state of this interface or port (Up, Down, or
Testing).

Configuration Views Fast Ethernet SmartSwitch Module
3-4 Management Module Guide



Port Configuration - CSlIfPort View

Port Configuration - CSlIfPort View

This view provides information on the configuration and operating status of
the device interfaces or ports.

To access the Port Configuration - CSlIfPort view for a particular interface or
port, do the following:

1. Within the Interface Device view, highlight the Interface icon.
2. From the View menu, select Icon Subviews -> Configuration.
This view provides the following information:

Interface Index
Displays the numerical value identifying the interface or port.

Interface Type
Displays the type of interface or port.

Operation Status
Displays the current operating status of the interface or port. Possible values
are On, Off, and Test.

Admin Status
Displays the current administrative status of the interface or port. Possible
values are On, Off, and Test.

IF Description
Provides a description of the interface or port.

9032073 E2
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FddiMAC Device Configuration View

FAddiMAC Device Configuration View

The FddiMAC Device Configuration view provides configuration and
operating status information.

To access this view, do the following:

1. Highlight the FddiMAC icon in the Application view (Icon mode) or the
FAdiMAC text label (List mode).

2. From the View menu, select Icon Subviews -> Configuration or click
the applicable mouse button (middle or right) and select Configuration.

Station Configuration

This section of the FddiMAC Device Configuration view provides the following
configuration information on the FDDI station.

Ring State
The current state of the FDDI Ring. Table 3-2 lists the possible states and
their descriptions.

Table 3-2. FDDI Ring States
SF:;?SS Description
Isolated The concentrator is not attached to the ring.
Non-Op The concentrator is attempting to enter the ring.
Ring-Op The ring is operational.
Detect The claim/beacon process of the FDDI ring protocol has exceeded

one second. This indicates a potential problem.

Non-Op-Dup | The ring failed to complete the claim/beacon process because a
duplicate FDDI address has been detected.

Ring-Op-Dup | The ring is operational, but a duplicate FDDI address has been

detected.

Directed The claim/beacon process did not complete within nine seconds.
The concentrator is now sending directed beacons to indicate a
problem.

Trace A problem has been detected with the station or its upstream

neighbor. A trace is being sent to notify the upstream neighbor of
the problem. The concentrator and all stations between the
concentrator and its upstream neighbor can perform self-tests.
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FddiMAC Device Configuration View
Station Configuration

MAC Configuration
The actual configuration of the station. Table 3-3 lists the possible configurations
and their descriptions.

Table 3-3. SMT MAC Configurations
Ring i
States Description
Isolated The path is not inserted into any path.
Local_A The A port is inserted into a local path and the B port is not.
Local_B The B port is inserted into a local path and the A port is not.

Local_AB Both A and B are inserted into a local path.

Local_S The S port is inserted into a local path.
Wrap_A The secondary path is wrapped to the A port.
Wrap_B The secondary path is wrapped to the B port.

Wrap_AB The primary path is wrapped to the B port and the secondary path
is wrapped to the A port.

Wrap_S The primary port is wrapped to the S port.

C_Wrap_A | The primary and secondary paths are joined internally in the
station and wrapped to the A port. Regarding token flow, all
resources on the secondary path precede those of the primary path.

C_Wrap_B | The primary and secondary paths are joined internally in the
station and wrapped to the B port. Regarding token flow, all
resources on the secondary path precede those of the primary path.

C_Wrap_S | The primary and secondary paths are joined internally in the
station and wrapped to the S port. Regarding token flow, all
resources on the secondary path precede those of the primary path.

Thru The primary path enters the A port and emerges from the B port.
The secondary path enters the B port and emerges from the A port.

Current MAC Path
The ring that this station resides on. Possible entries are Primary, Secondary,
or Local.

MAC Address
The MAC (physical) address of this station.

MAC Count
The number of MACSs supported by this station.

Non Master Ports
The number of non-master ports on this station.

Master Ports
The number of master ports on this station.
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Port Configuration View

SMT Information

SMT Information

This section of the FdAdiMAC Device Configuration view provides the following
configuration information on the FDDI SMT:;

SMT Version
The version of Station Management (SMT) running.

OBS Present
Indicates whether an Optical Bypass Switch (OBS) is connected.

T-Notify (sec)
The timer value, in seconds, used in Neighbor Notification Protocol. The
allowed range is from 2 to 30 seconds.

T-Req (milli sec)
The Target Token Rotation Time (TTRT) bid, in milliseconds, made by this
concentrator.

T-Neg (milli sec)
The winning TTRT bid, in milliseconds, on the ring.

TVX (milli sec)
The valid transmission time, in milliseconds.

Port Configuration View

The Port Configuration view provides information on the configuration and
operating status of the ports. To access this view, do the following:

1. Highlight the Logical Port icon in the Chassis Device view.

2. From the View menu, select Icon Subviews -> Port Configuration
View.

The Port Management section of the FDDI Port Configuration view provides
the following information:

Port Action
Allows you to enable/disable the port. The state returns to “Other” once the
port has been Enabled/Disabled.

Port State
The status of this port. Possible states are disabled, connecting, standby, and
active.

Port Type
The type of port. Possible port types are A_Port, B_Port, Slave, or Master.

Configuration Views Fast Ethernet SmartSwitch Module

3-8

Management Module Guide



Port Configuration View

Figure 3-1.

Link Error Rate Estimate

The link error rate estimate is a cumulative long-term average of the bit error
rate, which represents the quality of the physical link. The link error rate
estimate is computed when the port is connected and every 10 seconds
thereafter. It ranges from 104 to 1015 and is reported as a whole integer. For
example, if the port’s link error rate estimate is computed to be 10-°, the value
reported in this field would be 5, which represents an actual rate of 1,250 bit
errors per second. A lower link error rate estimate indicates a higher bit error
rate as shown in Figure 3-1.

Link Error Rate Estimate
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Reported Link Error Rate Estimate (n)

Link Error Monitor Count

The aggregate link error monitor count. This count is set to zero on station
power up and increments each time the port’s link error monitor detects an
error. An increasing link error monitor count usually indicates a problem with
the connectors or the cable between this port and the node.

Link Error Rate Cutoff

The link error rate threshold at which a link connection is flagged as faulty
and the port disabled by SMT. The default link error rate cutoff threshold is 7,
which represents 12.5 bit errors per second.

Link Error Rate Alarm

The link error rate threshold above which an alarm for the port will be
generated. The default link error rate alarm threshold is 8, which represents
1.25 bit errors per second.

Link Error Monitor Reject Count
The link error monitor count of the times the link has been rejected.
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Event and Alarm Messages

What Is in This Chapter

This chapter lists the types of events and alarms generated by the Fast
Ethernet SmartSwitch Modules and provides any probable cause messages
corresponding to these alarms.

Device Events and Alarms

Table 4-1 lists the SPECTRUM database directory paths (in bold) and the
messages displayed for the Event Log and Alarm Manager when applicable.

Table 4-1. Fast Ethernet SmartSwitch Module Events and Alarms

Alarm Manager Probable Cause

Message in the Event Log Message

CsEvFormat/Event00010306
No probable cause message
{d “%w- %d %m-, %Y - %T"} - A(n) {t}
device, named {m}, has been cold
started. (event [{e}])

CsEvFormat/Event00010307
No probable cause message
{d “%w- %d %m-, %Y - %T"}- A(n) {t}
device, named {m} has been warm
started, (event [{e}])

9032073 E2
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Device Events and Alarms

Table 4-1.

Fast Ethernet SmartSwitch Module Events and Alarms (Continued)

Message in the Event Log

Alarm Manager Probable Cause
Message

CsEvFormat/Event00010308

{d “%w- %d %m-, %Y - %T"} - A(n) {t}
device, named {m}, has detected a
communication Link Down. (event

[{elD)

CsPCause/Prob00010308

Communication link is down.

CsEvFormat/Event00010309

{d “%w- %d %m-, %Y - %T"}- A(n) {t}
device, named {m}, has detected a
communication Link Up. (event [{e}])

No probable cause message

CsEvFormat/Event0001030a

{d “%w- %d %m-, %Y - %T"} - A(n) {t}
device, named {m}, has detected an
Authentication Failure. (event [{e}])

CsPCause/Prob0001030a

Authorization failure. Other user is trying to
connect to device with an invalid community
string.

CsEvFormat/Event0001030b

{d “%w- %d %m-, %Y - %T"}- A(n) {t}
device, named {m}, has detected an
EGP Neighbor Loss. EGP Neighbor
IP address is {0 1}. (event [{e}])

CsPCause/Prob0001030b

Lost contact with EGP neighbor.

CsEvFormat/Event000d01a0

{d “%w- %d %m-, %Y - %T"} - A Port
Interface Module has been inserted
into port {I 3} of interface {I 1} on {m}
({t}). (event [{e}]).

CsPCause/Prob000d01a0

A Port Interface Module has been physically
inserted.

CsEvFormat/Event000d0lal

{d “%w- %d %m-, %Y - %T"} - A Port
Interface Module has been removed
from port {I 3} of interface {I 1} on

{m} ({t}). (event [{e}])

CsPCause/Prob000d0lal

A Port Interface Module has been physically
removed.

CsEvFormat/Event000d0l1a2

{d “%w- %d %m-, %Y - %T"} -
Network configuration change
reported by {m} ({t}). Device linked to
port {I 3} on interface {lI 1}. (event

[{elD)

CsPCause/Prob000d01a2

A device supporting link integrity, fiber optic or
twisted pair, has made a valid connection (link)
to this port.

Event and Alarm Messages
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Device Events and Alarms

Fast Ethernet SmartSwitch Module Events and Alarms (Continued)

Message in the Event Log

Alarm Manager Probable Cause
Message

CsEvFormat/Event000d01a3

{d “%w- %d %m-, %Y - %T"} - Port {l
3} on interface {I 1} of {m} ({t}), has
unsegmented. (event [{e}]).

CsPCause/Prob000d0l1a3

A device previously linked with this port has
been removed, powered down, or the cable
segment has a fault.

CsEvFormat/Event000d0351

{d “%w- %d %m-, %Y - %T"} - Front
panel redundant port {l 1} has been
activated by device {m} of type {t}.
(event [{e}])

CsPCause/Prob000d0351

A new port has been activated for the front
panel redundant circuit. This does NOT
indicate this port is usable, but is being tested.

CsEvFormat/Event000d0001

{d “%w- %d %m-, %Y - %T"} - {m} of
type {t} has reported a root change.
(event [{e}])

CsPCause/Prob000d0001

This bridge has become the new root of the
Spanning Tree.

CsEvFormat/Event000d0002

{d “%w- %d %m-, %Y - %T"} - Bridge
{m} of type (t) has reported a
network topology change (event

[{el)-

CsPCause/Prob000d0002

A port has transitioned from the Learning state
to the Forwarding state, or from the Forwarding
state to the Blocking state.

CsEvFormat/Event00830000

{d “%w- %d %m-, %Y - %T"} - DLM
LostContact trap for Destination
Address {0 1}, Owner Address {0 2}
from {t} device, named {m}. (event

[{elD).

No probable cause message

CsEvFormat/Event00830001

{d “%w- %d %m-, %Y - %T"} - DLM
Threshold Trap for Destination
Address {0 1}, Owner {0 2}, OID
sequence {I 3}, OID Object {0 4} from
{t} device, named {m}. (event [{e}]).

No probable cause message

CsEvFormat/Event00830002

{d “%w- %d %m-, %Y - %T"} - DLM
ReestabContact Trap for Destination
Address {0 1}, Owner Address {0 2}
from {t} device, named {m}. (event

[{elD}-

No probable cause message
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(L[| [ | Chapters

Application Views

What Is in This Chapter

This chapter describes the device-specific applications listed below for the Fast
Ethernet SmartSwitch Modules. The corresponding application model type is
shown in parentheses.

= Interface Remap (CtlIfRemapApp)
= Fast Ethernet (FastEnetApp)

= FDDI FNB Application (FddiMAC)
= ATM Application (ATM_Client)

« DownLoad App (CtDownLoadApp)

Common Applications Not Covered Here

This device supports the following common applications described in the
Application View Reference:

= Bridging (CSIBridge)
- Spanning Tree (Ct_Stp_App)
- Static (Static_App)
- Transparent (CT_Tp_Appl)
= MIB-11 (SNMP2_Agent)
- ICMP (ICMP_App)
- IP (IP2_App)
- System (System2_App)
- UDP (UDP2_App)
= RS-232 App (RFC1317App)

9032073 E2
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Device Application View

The following major application is available if you purchase the associated
Cabletron product. The application is described within the documentation
supplied with the product.

« Standard RMON (RMON App)

- Ethernet Probe 1(RMONEthProbe) through Ethernet Probe 16
(RMONEthProbe)

Device Application View
This view shows the common and device-specific applications supported by
this device and provides access to application-specific information.

Refer to Chapter 1, Introduction, for information on Accessing SPECTRUM
Views from the Device Icon.

Figure 5-1 shows an example of an Application view in the Icon mode.
Figure 5-2 shows an example of an Application view in the List mode.

To change the display mode, from the View menu select Mode -> List or Icon.

Application Views Fast Ethernet SmartSwitch Module
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Device Application View

Figure 5-1. Device Application View (Icon Mode)

=

Model Name Network Address System UpTime

Contact Manufacturer
Description Device Type
Location Primary Application Bridging Serial Number

IS

FddiMAC

- FddMAC

ICMP_App

{ICMP_App |

IP2_App

~IP2_App |

—omem |
‘_‘!.I—I.h_‘ System2_App

CT Tp_Appl !

SYSEETe_APH
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Device Application View

Figure 5-2. Device Application View (List Mode)

Model Name ] Network Address System UpTime

Contact 1 ks
Description _cabletron | DeviceType

Location PrimaryAppIication Bridging ~—  Serial Number

[ sssH

CSIBridge
CT_Stp_App
Static_App
CT_Tp_Appl

—— FddiMAC

L [ SNMP2_Agent
ICMP_App
IP2_App
System2_App
UDP2_App

— CtIfRemapApp
—— CtDownlLoadApp

—— FastEnetApp
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Interface Remap Application

Interface Remap Application

The name of the model type used to model the application is CtIfRemapApp.
The application provides the ability to map one or more interfaces to another
interface. A map is defined by creating a row in the Interface Remap Table
(described below) to specify the source and destination interfaces. When a
source interface is remapped to a destination interface, the destination
interface transmits all packets received or transmitted on the source
interface. Counters on the destination interface increment for all packets
transmitted by normal bridging or due to the interface remap. Figure 5-3
shows a view of the Interface Remap Table.

Access the Interface Remap Table as follows:

1. Highlight the CtIfRemapApp icon (Icon mode) or text label (List mode).
2. From the View menu, select Icon Subviews -> Port Remap.

The Interface Remap Table provides the following information:

Number Entries
The number of active entries in the Interface Remap Table.

Physical Errors Enable

Physical error remapping can be Enabled, Disabled, or Unsupported.
Unsupported indicates that the device is incapable of remapping physical
errors.

Max Number Entries
The maximum number of entries allowed in the Interface Remap Table.

Used to sort the Interface Remap Table.

Used to search the Interface Remap Table for a specific interface.

Used to update the Interface Remap Table.

Source Port
The source interface that will have packets redirected to the destination
interface as defined by Destination.

Destination
The interface that will see all packets redirected from Source Port.

9032073 E2
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Interface Remap Application

Port Redirectl

This button opens the Port Redirect view, where you can add or delete an
entry from the table.

Figure 5-3. Interface Remap Table

=

Name CtlfRemapApp Network Address System Up Time

Contact Manufacturer

Description Device Type

Location Primary Application Bridging Serial Number

Interface Remap Table

Number Entries Physical Errors Enable Enable Max Number Entries

Sort Find Update

Source Port Destination

Port Redirect
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Fast Ethernet Application

Fast Ethernet Application

The name of the model type used to model the application is FastEnetApp.
The application provides the Fast Ethernet Port Table and Fast Ethernet
Configuration view, which allow you to configure ports for Ethernet or Fast
Ethernet transmission or use Auto-Negotiation to determine transmission
mode.

Fast Ethernet Port Table

Access this table as follows:

1. Highlight the FastEnetApp icon (Icon mode) or text label (List mode).
2. From the View menu, select Icon Subviews -> Control Table.

The Fast Ethernet Port Table provides the following information:

Interface
The interface number to which this Fast Ethernet information applies.

Port Group
The port group number to which this Fast Ethernet information applies.

Port
The physical port number to which this Fast Ethernet information applies.

Operational Mode
The current operational mode of this port.

Fast Ethernet Configuration View

This view (Figure 5-4) allows you to configure ports for Ethernet or Fast
Ethernet transmission or to use Auto-Negotiation in determining
transmission mode. Open this view by double-clicking any entry in the Fast
Ethernet Port Table. The Fast Ethernet Configuration view carries the
Interface, Port Group, and Port information over from the Port Table.

9032073 E2 Application Views
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Fast Ethernet Application

Fast Ethernet Configuration View

Figure 5-4.

Model Name
Contact
Description

Location

Interface

Fast Ethernet Configuration View

Network Address System Up Time
Manufacturer
Device Type

Primary Application [ Bridging Serial Number

Port Group

Operational Mode

Auto-Negotiation 100BaseTX 100BaseFX
10BaseT 100BaseTXFD 100BaseFXFD
10BaseTFD 100BaseT4

Advertised Ability

10BaseT 100BaseTXFD 100BaseFXFD
10BaseTFD 100BaseT4
100BaseTX 100BaseFX

Received Technology

Undefined 10BaseT 100BaseTXFD 100BaseFXFD
Auto-Negotiation 10BaseTFD 100BaseT4
Not-Detected 100BaseTX 100BaseFX

Operational Mode

These selections indicate the current operational mode of this port. If you
select Auto-Negotiation, you can select as many modes as needed from the
Advertised Ability selections. You can only select one Operational Mode: either
Auto-Negotiation or one of the specific modes. Table 5-1 lists the current
operational modes, their values, and their descriptions.

Application Views
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Fast Ethernet Application

Fast Ethernet Configuration View

Table 5-1. Current Operational Mode Values and Descriptions
Operational .

Mode Value Description
Auto-Negotiation | 2 Auto-Negotiation/Parallel Detection
10Base-T 8 10Base-T
10Base-TFD 16 Full Duplex 10Base-T
100Base-TX 32 100Base-TX
100Base-TXFD 64 Full Duplex 100Base-TX
100Base-T4 128 100Base-T4
100Base-FX 256 100Base-FX
100Base-FXFD 512 Full Duplex 100Base-FX

Advertised Ability
These selections indicate the advertised ability of the local hardware. They
become active on ports that have Auto-Negotiation enabled. Auto-Negotiation
allows the FE-100TX RJ-45 port to self-configure to 10 or 100 Mbps depending
on the speed of the attached device. The interfaces can also dynamically
configure themselves for full duplex or half duplex (standard mode) operation
when both ends of the link support Auto-Negotiation. When only one link
partner supports Auto-Negotiation, the mode defaults to half duplex.
Both local and remote management for the Fast Ethernet SmartSwitch
Module provide the ability to disable Auto-Negotiation if desired. A port that
does not support Auto-Negotiation will be read as “other” (1).
Table 5-2 lists the Advertised Ability modes, their values, and their
descriptions.
Table 5-2. Advertised Ability Mode Values and Descriptions
Advertised .
Ability Value Description
10Base-T 8 10Base-T
10Base-TFD 16 Full Duplex 10Base-T
100Base-TX 32 100Base-TX
100Base-TXFD 64 Full Duplex 100Base-TX
100Base-T4 128 100Base-T4
9032073 E2 Application Views
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Fast Ethernet Application

Fast Ethernet Configuration View

Table 5-2.

Table 5-3.

Advertised Ability Mode Values and Descriptions

Advertised

Ability Value Description
100Base-FX 256 100Base-FX
100Base-FXFD 512 Full Duplex 100Base-FX

Received Technology

These selections indicate the advertised ability of the remote hardware or link
partner. These modes are read-only. Table 5-3 lists the Received Technology
modes, their values, and their descriptions.

Received Technology Mode Values and Descriptions

Tsfﬁﬁ:)\:ggy Value Description

Undefined 1 Undefined

Auto-Negotiation Auto-Negotiation/Parallel Detection

Not-Detected 4 Link Partner does not support Auto-
Negotiation

10Base-T 8 10Base-T

10Base-TFD 16 Full Duplex 10Base-T

100Base-TX 32 100Base-TX

100Base-TXFD 64 Full Duplex 100Base-TX

100Base-T4 128 100Base-T4

100Base-FX 256 100Base-FX

100Base-FXFD 512 Full Duplex 100Base-FX

Application Views
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FDDI FNB Application

FDDI FNB Application

Table 5-4.

This section describes the FDDI FNB application supported by this device.
The name of the model type used to model the application is FAdiMAC. This
application is available when the appropriate High Speed Interface Module
(HSIM) is installed.

Table 5-4 lists the application-specific subviews available from the Icon
Subviews menu for the FDDI FNB application.

FDDI FNB Application Subviews menu

Menu Selection Description

DevTop Opens the Device Topology view described in the Operator’s
Reference.

Station List Opens the FDDI Station List view described below.

Acknowledge Allows you to acknowledge an alarm condition.

Configuration Opens the Device Configuration view described in Chapter 3,
Configuration Views.

Model Information | Opens the Model Information view described in the
Operator’s Reference.

FDDI Station List View

This view displays information about the devices connected to the FDDI ring
and provides the following functionality and information.

This button updates the contents of the Station Table.

| MAC/Canonical |

This button controls which type of address is shown in the Station List. It
toggles between MAC (Physical) and Canonical (Ethernet) and displays the
format not currently selected.

Set Filter/Clear Filterl

Set Filter Opens the Filter Dialog box for the selected column of the Station
table. Type a character string to search the column.

Clear Filter returns the Station table to its normal state.

9032073 E2
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FDDI FNB Application

FDDI Station List View

Table 5-5.

This button has three possible states: Sort Up, Sort Down, and Unsort.

Sort Up organizes the list within a selected column from the lowest
alphanumeric value to the highest.

Sort Down organizes the list within a selected column from the highest
alphanumeric value to the lowest.

Unsort returns the fields to their normal state.

Station Address
Displays the MAC or Canonical address of this node on the ring.

Node Class
Displays the type of FDDI ring device. Table 5-5 lists the possible node
classes.

FDDI Node Classes

Node Class Description

Station An FDDI node capable of receiving, transmitting, and repeating
data.

Concentrator | An FDDI node that provides attachment points for stations that

are not directly connected to the FDDI ring.

Ring Topology
Displays the current state of this FDDI node.

Master Ports
Displays the number of master ports on this node. Values range from 0 to 255.

Upstream Neighbor
Displays the canonical or MAC address of the last node to receive the token
before this node.

Application Views
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ATM Client Application

ATM Client Application

Table 5-6.

This section describes the ATM Client application supported by this device.
This application is available when the appropriate High Speed Interface
Module (HSIM) is installed.

Table 5-6 lists the application-specific subviews available from the Icon
Subviews menu for the ATM Client application:

ATM Client Application Subviews menu

Menu Selection Description

Configuration Opens the Device Configuration view described in Chapter
3, Configuration Views.

Model Information Opens the Model Information view described in the
Operator’s Reference.

VCL Table Opens the ATM Client Application VCL (Virtual Channel
Link) Table view described later in this chapter.

Interfaces Opens the Interfaces view described later in this chapter.

ATM Client Application VCL View

This view provides a table containing detailed information about the virtual
channels passing through this application. The ATM Client Application
Virtual Channel Link view provides the following information.

Admin Status

This object is implemented only for a VCL that terminates a VCC (i.e., one
that is not cross-connected to other VCLS). Its value specifies the desired
administrative state of the VCL. The Up state indicates that the traffic flow
for this VCL is enabled. The Down state indicates that the traffic flow for this
VCL is disabled.

Oper Status

This object shows the current operational status of the VCL. The Up and
Down states indicate that the VCL is currently operational or not operational,
respectively. The Unknown state indicates that the status of this VCL cannot
be determined.

Last Change

This is the value of the MIB II's sysUpTime object at the time the VCL entered
its current operational state. If the current state was entered prior to the last
re-initialization of the agent, then this object contains a zero value.

RTD (Receive Traffic Description) Index
The value of this object identifies the row in the ATM Traffic Descriptor Table
that applies to the receive direction of this VCL.

9032073 E2

Application Views
5-13



ATM Client Application
ATM Client Application VCL View

TTD (Transmit Traffic Description) Index
The value of this object identifies the row of the ATM Traffic Descriptor Table
that applies to the transmit direction of this VCL.

AAL (ATM Adaptation Layer) Type

An instance of this object only exists when the local VCL endpoint is also the
VCC endpoint and the AAL is in use. The type of AAL used on this VCC
includes AAL1, AAL3/4, and AALS5. “Other” indicates a user-defined AAL type.
“Unknown” indicates that the AAL type cannot be determined.

Transmit Size

This is the maximum AAL5 CPCS SDU size, in octets, that is supported on the
transmit direction of this VCC. An instance of this object only exists when the
local VCL endpoint is also the VCC endpoint and the AALS5 is in use.

Receive Size

This is the maximum AAL5 CPCS SDU size, in octets, that is supported on the
receive direction of this VCC. An instance of this object only exists when the
local VCL endpoint is also the VCC endpoint and the AAL5 is in use.

Encaps Type

This is the type of data encapsulation used over the AAL5 SSCS layer. An
instance of this object only exists when the local VCL endpoint is also the VCC
endpoint and the AALS5 is in use. The definitions reference RFC 1483
Multiprotocol Encapsulation over ATM AALS5 and to the ATM Forum LAN
Emulation specification.

VCL CC (Cross Connect) Id

This object is implemented only for a VCL that is cross-connected to other
VCLs that belong to the same VCC. All such associated VCLs have the same
value for this object, and all their cross-connections are identified by entries in
the Cross Connect Table for which VCL CC Id has the same value. The value
of this object is initialized by the agent after the associated entries in the
Cross Connect Table have been created.

Row Status

This object is used to create, delete, or modify a row in this table. To create a
new VCL, this object is initially set to “createAndWait” or “createAndGo.” This
object must not be set to “active” unless the following columnar objects exist in
this row:

« RTD Index

 XTD Index

= AAL Type (if the local VCL endpoint is also the VCC endpoint)
= Transmit Size (for AAL5 connections only)

= Receive Size (for AAL5 connections only)

= Encaps Type (for AAL5 connections only)

Application Views Fast Ethernet SmartSwitch Module
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ATM Client Application

ATM Client Application VCL View

Jasasasas The Community Name field in the Communication Information Panel of the
NOTE Model Information view must be set to “private” in order to change the fields
in the table views.

To make a change to the rows in the table view, do the following:

1. Inthe Communication Information panel of the Virtual Link view, change
the Community Name field to “private.”

2. From the Icon Subviews menu, select Table View.

3. Set the path information for the row you wish to create, change, or
remove.

4. Press Return and click on OK.

5. To create or change a row, click on the Create button, change the
applicable fields in the Change view, and click the right mouse button.
Click OK.

6. Click on the Validate Row button and return to the Application Table
view to see the change.

7. Toremove a row, click on the Remove button and then the Update
button. The row will then be removed from the table view.

The Virtual Channel Link table can be sorted, searched, and updated using

the following buttons within the view:

This button allows you to sort the table based on the column heading you

select. To use the Sort feature, select a column heading and click on the Sort

button. The table is rearranged according to the chosen column.

This button allows you to search the table for a specific entry. To use the Find

feature, select a column heading, click on the Find button, and enter a search

string in the dialog box.
Update

This button allows you to update information in the table.

Double-clicking on a field entry opens the interface-specific ATM Switch

Application Virtual Channel Link view, which contains the following

information. You can change these fields.

Interface

This field displays the interface index for this VPI and VCI.
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ATM Client Application

ATM Client Application VCL View

VPI (Virtual Path Identifier)
This field displays the VPI value of the VCL. The maximum VPI value cannot
exceed the value allowable by the Interface MaxVPI Bits.

VCI (Virtual Channel Identifier)
This field displays the VCI value of the VCL. The maximum VCI value cannot
exceed the value allowable by the Interface MaxVCI Bits.

Admin Status

This object is implemented only for a VCL that terminates a VCC (i.e., one
that is NOT cross-connected to other VCLS). Its value specifies the desired
administrative state of the VCL. The Up state indicates that the traffic flow is
enabled for this VCL. The Down state indicates that the traffic flow is disabled
for this VCL.

Oper Status

This object indicates the current operational status of the VCL. The Up and
Down states indicate that the VCL is currently operational or not operational,
respectively. The Unknown state indicates that the status of this VCL cannot
be determined.

Row Status

This object is used to create, delete, or modify a row in this table. To create a
new VCL, this object is initially set to “createAndWait” or “createAndGo.” This
object must not be set to “active” unless the following columnar objects exist in
this row:

< RTD Index

« XTD Index

= AAL Type (if the local VCL endpoint is also the VCC endpoint)
= Transmit Size (for AAL5 connections only)

= Receive Size (for AALS5 connections only)

< Encaps Type (for AAL5 connections only)

Encaps Type

This is the type of data encapsulation used over the AAL5 SSCS layer. An
instance of this object only exists when the local VCL endpoint is also the VCC
endpoint, and AALS is in use. The definitions reference RFC 1483
Multiprotocol Encapsulation over ATM AALS5 and to the ATM Forum LAN
Emulation specification.

AAL (ATM Adaptation Layer) Type

This is the type of AAL used on this VCC, which includes AAL1, AAL3/4, and
AALDS5. An instance of this object only exists when the local VCL endpoint is
also the VCC endpoint, and AAL is in use. The other may be a user-defined
AAL type. The Unknown type indicates that the AAL type cannot be
determined.

Last Change

The value of MIB II's sysUpTime object at the time this VCL entered its
current operational state. If the current state was entered prior to the last re-
initialization of the agent, then this object contains a zero value.
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Download Application View

Cross Connect Id

This object is implemented only for a VCL that is cross-connected to other
VCLs that belong to the same VCC. All such associated VCLs have the same
value of this object, and all their cross-connections are identified by entries in
the Cross Connect Table for which VCL CC Id has the same value. The value
of this object is initialized by the agent after the associated entries in the
Cross Connect Table have been created.

Xmit Descr Index
The value of this object identifies the row of the ATM Traffic Descriptor Table
that applies to the transmit direction of this VCL.

Transmit Size

An instance of this object only exists when the local VCL endpoint is also the
VCC endpoint, and AALS5 is in use. The maximum AAL5 CPCS SDU size in
octets that is supported on the transmit direction of this VCC.

Rcv Descr Index
The value of this object identifies the row in the ATM Traffic Descriptor Table
that applies to the receive direction of this VCL.

Receive Size

An instance of this object only exists when the local VCL endpoint is also the
VCC endpoint, and AAL5 is in use. The maximum AALS5 CPCS SDU size in
octets that is supported on the receive direction of this VCC.

Download Application View

This application provides download functionality for this device. The model
type for this application is CtDownLoadApp. Access the Download Application
view as follows:

1. Within the Application view, highlight the CtDownLoadApp icon (Icon
mode) or model type name (List mode).

2. From the View menu, select Icon Subviews -> Download Application.

The Download Application view is an SPMA view, which is described in the
SPECTRUM Portable Management Application Tools Guide.
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